
 

 

  



 

Аннотация 

программы «Введение в принципы 3D-сканирования» 

дополнительного образования детей   

 

ЦТПО _____НИЯУ МИФИ_________     Возраст 15-16 лет 

   (наименование вуза) 

Тематика 3D-сканирование объектов с использованием маркеров 

 

 

Цель программы: приобретение учащимся навыков создания и обработки 3D-моделей 

реальных объектов методом 3D-сканирования. 

 

 Задачи программы: 

- ознакомление с принципами 3D-сканирования; 

- изучение основ работы в программах RVScan и ICP3, методов управления параметрами 

сканирования, обработки получаемых моделей; 

- освоение техники 3D-сканирования, формирование практических навыков для 

получения  3D-снимков; 

- освоение методики построения единой 3D-модели из набора связанных снимков. 

 

Результаты обучения: 

- знание последовательности и особенностей процесса 3D-сканирования, методов 

оптимизации параметров сканирования; 

- знание методов и владение навыками обработки получаемых 3D-сканов, умение строить 

единую модель методом сшивки по опорным точкам. 

 

Общий объем  учебного курса:    2 часа, в т. ч.  

лекции        0 часов; 

Лабораторные и практические занятия   2 часов; 

Самостоятельная работа     0 часов; 

Промежуточный контроль    0 часа; 

Аттестационная работа     0 часа. 

 

Ключевые слова:    3D-моделирование; 3D-сканирование; сканирование по маркерам; 

обработка 3D-сканов; построение 3D-модели. 
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ПОЯСНИТЕЛЬНАЯ ЗАПИСКА 

Данный курс входит в состав учебно-методического комплекса 

лаборатории Центра технической поддержки образования (ЦТПО) НИЯУ 

МИФИ.  Курс является одним из обзорных для направления  «3D-

моделирования». 

Задача данного курса – ознакомление с принципами 3D-

сканирования, получение базовых навыков построения трехмерных моделей 

реальных объектов. Учащиеся получают знания об устройстве 3D сканера на 

примере установки, собранной на безе проектора и двух камер. В рамках 

практической части занятия исследуют шумы и возможные искажения 

возникающие в ходе сканирования, осваивают методы оптимизации 

сканирования и получения наиболее качественных моделей. Отдельное 

внимание уделено обработке полученных результатов и построению единой 

модели сканируемого объекта. 

Цели курса: сформировать у учащихся представления о методах 3D-

сканирования, умение оптимизировать работу установки и получать 

качественные результаты. 



 

ТРЕБОВАНИЯ К УРОВНЮ ПОДГОТОВКИ УЧАЩИХСЯ 

Данный курс рассчитан на учащихся 7 -10 классов,  обладающих 

базовыми умениями работы с ПК. 

 

Результаты обучения 

1. Общие 

учебные умения 

1.1 Умения, связанные с познавательной деятельностью 

- использует известную последовательность действий для 

достижения учебной цели 

- оптимизирует работу установки для достижения 

лучшего результата 

2. Специальные 

предметные 

умения 

2.1 Умения, связанные с принципами 3D-сканирования 

- получает модели поверхностей 

- получает модели объектов 

2.3 Умения, связанные с обработкой получаемых 

результатов 

- удаляет лишние области и артефакты, возникшие в 

процессе сканирования 

- выполняет сшивку получаемых 3D-моделей 

2.3 Умение, связанные с настройкой аппаратуры 

- приобретает знание о понятиях «экспозиция», «время 

накопления» 

 



 

УЧЕБНО-ТЕМАТИЧЕСКИЙ ПЛАН 

№№ Наименование разделов и тем Всего 

часов 

В том числе, часов 

Теория Практика 

1 Введение в методы и принципы 3D-

сканирования 

1 1  

2  Получение единой трехмерной 

компьютерной модели объекта 

 

1  1 

 



 

СОДЕРЖАНИЕ ПРОГРАММЫ 

Введение в методы и принципы 3D-сканирования. 

Понятие процесса 3D сканирования, ключевые элементы установки.  

Практическая работа. 

Получение сканов поверхностей объектов. Оптимизация параметров 

сканирования. Сшивка и построение единой модели. 
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План урока (90 мин) 

1) Объяснение правил техники безопасности при выполнении работ в 

лаборатории. Оформление журнала по технике безопасности (5 мин). 

2) Объяснение основных принципов 3d-сканирования (20 мин). 

Требования к объектам сканирования. Основные источники шумов и 

возможные помехи, неточности сканирования. Принцип сшивки единой 

модели. Сканирование по маркерам, по опорной сетке. 

3) Ознакомление с оборудованием и правила пользования установкой (5 

мин). 

4) Подготовка прибора к сканированию (20 минут). 

Настройка камер. Определение правильного расстояния до объекта. 

Пробный скан, настройка области сканирования 

5) Сканирование объекта с различных ракурсов с использованием 

маркеров для последующей сшивки. (15 мин) 

6) Обработка и сшивка полученных в предыдущем задании сканов, 

построение единой модели в формате *.stl (15 мин) 

5) Подведение итогов занятия (10 мин). 

Обсуждение возникших при сканировании трудностей 

7) Выключение установки и приведение в порядок рабочего места (5 

мин). 



 

Введение 

В области 3D-моделирования, наряду с задачами разработки и 

создания компьютерных и физических моделей, стоит задача оцифровки и 

сбора данных о геометрии реальных объектов. Понятие 3D-сканирования 

включает в себя набор методов и средств, используемых для получения 

компьютерных трехмерных моделей исследуемого образца. Принципиально 

способы такого сканирования можно разделить на контактные и 

бесконтактные. В то время как профилометры и подобные им устройства 

требуют непосредственного соприкосновения элементов сканера с 

образцом, бесконтактные методы основаны на регистрации света 

исходящего от образца. Возможно построение таких систем для 

обнаружения и анализа естественного света отраженного от образца 

(пассивные сканеры), либо с использованием специального подсвета 

(активные сканеры).  

В представленном курсе ученикам предлагается ознакомиться с 

системой 3D-сканирования, построенной на базе проектора и двух камер. 

Процесс сканирования представляет собой обработку изображений, 

наблюдаемых камерами при подсвете образца проектором. Анализ этих 

изображений производится автоматизировано, в программе RVScanner, 

которая так же управляет и подсветом. Объект освещается изображением, 

состоящим из белых линий и полос различной ширины и периодичности 

следования, статичных, либо подвижных. Так же программа RVScanner 

позволяет просматривать полученные 3D-сканы, их взаимное расположение 

в пространстве. Для постобработки (удаление лишних участков, глобальная 

сшивка и прочее) используется программа ICP3. 

 



 

Основы работы с программой RVScaner 

На рисунке 1 изображено рабочее окно программы RVScanner.  

Два больших нижних поля отображают наблюдаемые камерами 

изображения и служат для подготовки прибора к сканированию: настройки 

параметров, правильного размещения исследуемого объекта в области 

сканирования.  

В верхнем поле будут отображаться получаемые сканы, которые 

возможно поворачивать для детального изучения. Следует отметить, что в 

этом поле показаны лишь упрощенные эскизы сканов, и по ним невозможно 

судить о качестве реально построенной «тяжелой» модели.  

Правая панель позволяет управлять подсветом, выбирать 

необходимые для настройки режимы. Верхняя панель позволяет выбрать 

режим отображения (только 3D, только левая камера, только правая камера, 

все три элемента на одном экране), выбрать режим для получения набора 

сканов с разных ракурсов (об этих режимах речь пойдет далее), настроить 

выдержку камер и запустить процесс сканирования. 

 

 

Рис.1 Окно программы RVScanner. 



 

Начиная сканирование объекта, следует создать новый проект. Все 

получаемые результаты будут сохраняться во внутреннюю папку 

автоматически. 

Описание горячих клавиш, которые могут быть использованы при 

работе с программой RVScanner, приведено в таблице 1. 

 

 

Таблица 1. Горячие клавиши RVScanner. 

Действие Комбинация 

Ctrl+N Создать новый проект 

Ctrl+O Открыть проект 

Ctrl+X Закрыть проект 

Ctrl+S Экспорт результата 

Ctrl+Q Выход из программы 

Ctrl+→ Вид с правой камеры 

Ctrl+← Вид с левой камеры 

Ctrl+↑ Вид модели 

Ctrl+↓ Вид с камер и модель 

Space Начать сканирование 

Back space Остановить сканирование 

Del Удалить выделенный скан 

Q Режим сканирования «модель и маркеры» 

W Режим сканирования «маркеры» 

A Подсвет «Крест» 

S Выключить подсвет 

D Подсвет «Белый свет» 

F Подсвет «Линии и полосы» 



 

G Настройка яркости 

Alt+S Сохранить снимки 

 



 

Особенности 3D-сканирования 

На качество получаемых сканов оказывают влияние множество 

факторов, как внешних, так и связанных с особенностями сканируемых 

объектов. Правильная настройка параметров сканирующей системы важна 

для получения качественных 3D-моделей. 

Большое время экспозиции (время накопления сигнала) позволяет 

камерам собирать для анализа максимально контрастные изображения. Под 

словами «максимально контрастный» подразумевается максимальная 

разница в яркости между светлыми и темными полосами. В таком случае 

программе проще определить отклонения границ полос. Казалось бы, тогда 

это время всегда следует выбирать максимальным? Однако чрезмерно 

долгое накопление чревато засветкой матрицы (попадание слишком 

большого количества света на один или несколько пикселей) и 

невозможностью обработки таких изображений. 

Главным источником внешних помех является комнатное освещение. 

Излучение ламп дневного света воспринимается человеком как 

непрерывное, однако на самом деле оно изменяется периодически, так как 

питание осуществляется сетевым переменным током с частотой ~50 Гц. В 

процессе сканирования на объект подаются как  статичные, так и 

динамические изображения. Наложение периодически изменяющегося 

освещения и подсвета проектора регистрируется камерами, что может 

привести к появлению искажений. Например плоская поверхность может 

оказаться воспринятой как гофрированная. Очевидным способом борьбы с 

таким шумом является исключение внешнего освещения. Если для работы 

требуется оставить установку освещенной, возможна минимизация 

искажений при установке малой выдержки камер. 

Некоторые требования предъявляются и к самому сканируемому 

объекту. Все они связаны с корректностью регистрации изображений 

камерами. Объект не должен иметь блестящих, глянцевых поверхностей, во 

избежание засвета, либо определения таких поверхностей более светлыми 

чем они есть на самом деле. Ошибки сканирования возможны так же в 

местах, где поверхность имеет слишком контрастную окраску. Такие участки 

могут быть восприняты как границы линий подсвета. 



 

Использование маркеров 

Очевидно, что одним сканом невозможно охватить всю поверхность 

объекта. Для получения полной информации необходимо выполнить серию 

сканирований и только потом сшить их в единую 3D-модель. Получение 

такой серии возможно тремя различными способами, которые отличаются 

определением взаимной ориентации сканов в пространстве. 

1. Набор сканов с различных ракурсов, которые вручную подгоняются 

друг к другу. Такой способ является самым простым и быстрым, но в то 

же время самым неточным, высоко влияние человеческого фактора. 

2. Сканирование объекта с нанесенными на него маркерами. 

Позволяет программно связывать сканы между собой по совпадающим 

маркерам. Уникальные комбинации маркеров распознаются при 

обработке, таким образом, отслеживается поворот двух снимков 

относительно друг друга. Успех такого сканирования во многом зависит 

от того, как нанесены маркеры. Максимально хаотическое их 

расположение будет оптимальным для распознавания программой. 

Для удобства возможна маркировка жестко связанного с исследуемым 

опорного объекта. В случае такого сканирования, все снимки уже 

ориентированы в пространстве, и готовы к сшивке. 

3. Сканирование по опорной сети во многом похоже на предыдущий 

описанный способ, однако распознанные комбинации маркеров 

связываются не с предыдущим сканом, а с заранее созданной опорной 

сетью. 

Маркеры представляют из себя высококонтрастные точки, легко 

распознаваемые программой RVScanner. 

 



 

Задание 1. Настройка параметров сканирования 

Для успешного получения сканов поверхностей следует выставить 

оптимальные параметры для каждого конкретного скана.  

Выдержка объективов, или время экспозиции, настраивается из 

соображений максимальной контрастности, но не допуская засветки 

матрицы. Засвеченные пиксели будут показаны на экране компьютера 

красными точками (см. рис.1). Добейтесь оптимальной экспозиции. Для 

этого: 

1. Включите режим подсвета Линии и полосы. 

2. Откройте диалог Настройка яркости. 

3. Установите яркость линий в 255 (максимальное значение), яркость 

полос в 0. 

4. Регулируя экспозицию камер (ползунок в верхней панели 

инструментов) добейтесь максимально значения экспозиции при котором не 

появляются красные точки на изображениях линий.* 

5. Отрегулируйте яркость полос в максимальное значение при котором 

не появляются красные точки на полосах. 

* - области изображения, не принадлежащие объекту сканирования, не 

имеют значения. 

Так же, для получения качественного результата, необходимо 

правильно разместить сам объект в зоне сканирования. Выбор оптимального 

расстояния от проектора и камер до объекта производится при помощи 

подсвета “Крест”, включить который можно из правой панели инструментов. 

Разместите сканируемую поверхность так, чтобы крест совпадал с 

синими перекрестиями на камерах.  

Задание 2. Нанесение маркеров 

Для получения связанных сканов для последующей сшивки одним из 

способов является сканирование по маркерам. 



 

Нанесите маркеры на сканируемый объект, либо на жестко связанный 

с ним опорный объект. Маркеры следует наносить в максимально хаотичном 

порядке, так чтобы любые их комбинации были уникальными. Расстояние 

между соседними маркерами должно быть порядка нескольких 

сантиметров.  



 

Задание 3. Получение пары связанных сканов 

1. Войдите в режим сканирования по маркерам. 

2. Запустите первое сканирование и получите один качественный скан. 

Программа автоматически идентифицирует нанесенные в предыдущем 

задании маркеры.  

3. Поверните сканируемый объект на некоторый угол. Поворот должен 

привносить в область сканирования новые грани/особенности объекта, но 

не должен быть слишком большой для возможности ассоциации сканов 

по маркерам. Следите при этом, что бы расстояние до сканируемой 

поверхности сохранялось правильным. 

4.Запустите новое сканирование. Теперь маркеры будут подсвечиваться 

различными цветами: зеленый – маркер проассоциирован с одним из 

предыдущих сканов, желтый – маркер определен как новый. Для 

успешной сшивки необходимо совпадение как минимум трех маркеров. 

возможна так же ошибка ориентации скана в пространстве в этом случае 

следует повторить сканирование, возможно подкорректировать угол. 

Удачное выполнение задания 2 позволяет практически полностью 

исключить такие ошибки. 

Задание 4. Получение полного набора сканов для сшивки 

Используя процедуру описанную в задании 3, получите набор сканов 

объекта с различных ракурсов, содержащих информацию о всех 

особенностях его поверхности. 

Следите за корректностью ассоциации маркеров между собой. Два 

соседних скана должны иметь минимум 3 общие опорные точки и 

согласующуюся ориентацию в пространстве. 



 

Задание 5. Обработка и построение единой модели 

1. Перенесите полученные сканы в программу ICP3.  Для этого сначала 

сохраните результаты, полученные в предыдущем задании. В окне 

программы RVScanner выберите «Файл → Экспорт результатов».  

В открывшемся диалоге следует выбрать «Сохранить как «X». X-файлы  

предназначены для последующей обработки в ICP3. Таким образом набор 

сканов будет сохранен в папку _Export, внутри проекта. Чтобы для 

дальнейшей обработки и сшивки просто перетащите содержимое папки 

_Export в главное окно ICP3 и дождитесь пока файлы появятся в дереве 

объектов. Для удобства работы сканы нужно сгруппировать в папку. 

Щелкните правой клавишей мыши в дереве объектов и выберите «Create 

folder». Выделите все необходимые сканы и перетащите их в созданную 

папку 

2. Удаление лишних участков. Вращением объекта установите его 

необходимым для удаления краев ракурсом. После этого воспользуйтесь 

инструментом «Выделение прямоугольником» (либо «Выделение кистью») и 

укажите границы объекта. Таким образом будет выбрана область внутри 

выделения. Чтобы изменить выбор на внешнюю область откройте диалог 

Edit Selection (Tools -> Edit) и нажмите кнопку Invert. В результате будет 

выделено все кроме модели, и всё лишнее можно удалить нажав “Delete 

Selected”. 

3. Глобальная сшивка. Откройте диалог Registration (Tools -> Global 

registration). Выберите папку с Вашими сканами и нажмите «Select as 

moved». Выставите в диалоге параметры так, как показано на рисунке 2 и 

нажмите «Global register». Через некоторое время появится окно с 

информацией об отклонениях, времени обработки. Это означает, что сшивка 

выполнена.  



 

 

Рис.2. Диалог Registration. 

На данном этапе рекомендуется выполнять резервное сохранение 

результата. 

Меню File → Save all сохраняет все объекты, загруженные в программу 

в один X-файл. 

4. Построение единой STL-модели. Выделите папку со сшитыми 

сканами и выберите меню Tools -> Union model. Перед вами откроется 

диалог «Isosurface generation» в котором следует: 

4.1 Нажать кнопку «Select group”. 

4.2 В окошке Enter Value выставить шаг сетки, от которого зависит 

детализация. С одной стороны выставление маленького шага дает высокую 

детализацию, но с другой ведет к возможности появления артефактов и 

существенного увеличения времени обработки. Рекомендуемое значение 

шага сетки – 0,3. 

4.3 Для автозаполнения трех окошек «Unit sizes» нажимаем кнопку 

«Auto Fill». 

4.4 Нажатием кнопки «Generate» запускаем процесс генерации единой 

модели. 

Об окончании процесса создания единой модели свидетельствует 



 

появление окна, в котором показано затраченное на операцию время. Новая 

3D-модель будет находится в сцене вместе с исходными сканами. Чтобы её 

можно было лучше рассмотреть, следует скрыть папку (группу) сканов.  

Выделите модель в дереве и откройте диалог « Сохранить 

выделенный» (File -> Save selected). В диалоге выберете расширение STL и 

нажмите «Save». Таким образом будет получен результат всей проделанной 

в заданиях 1-5 работы. 
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УЧЕБНО-МЕТОДИЧЕСКИЕ СРЕДСТВА ОБУЧЕНИЯ 

1. Средства цифровой обработки, хранения и отображения информации 

(компьютер) с установленными программами RVScanner, ICP3. 

 


